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What’s new in 

Dolphin Management 

Welcome to Dolphin Management 10.1!  

This document provides an overview of many of the new features that have been added since 
versions 9 and 10. It is presented in reverse-chronological order, with Version 10.1 features, 
followed by V10.1 Specialty Module features, followed by Version 10 features. 

Dolphin Management 1.10 is designed to work under Windows 7, Windows 8 and 8.1, Windows 
10, Windows Server 2008 or higher, and SQL Server 2008 R2 or higher. Please see 
www.dolphinimaging.com for complete technical specifications. Dolphin Imaging 11.9 and 
Aquarium 3.4 are recommended for use with Dolphin Management 10 and 10.1 
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New Management Features in 10.1 

Global 
• We added a right-click option to show or hide group membership when viewing relationships on the 

Treatment Card, Edit a Patient, Patient Navigator, Edit a Doctor, Billing Party, Edit an Employee, and Edit 
a Non-Patient screens. Dolphin keeps this setting per computer and per screen until you change it. 

• Any time you navigate to the Lookup a Patient screen, you can now search for a patient using the Billing 
Party Phone number. 

• We added a new Proposals icon to the Main icon pane. This is another way to access patient 
treatment/contract proposals, which previously you could access only through the  Edit a Patient, Fees tab. 

AnywhereDolphin/MyOrthodontist Integration 
• To support an upcoming feature in MyOrthodontist, version 4.5, we added the Initial Photo Capture group 

box to the MyOrthodontist tab of MyOrthodontist/AnywhereDolphin Setup and Defaults. Click the Enable 
if patient has no timepoints/images check box to activate this feature. You then have the option to specify 
an initial timepoint name, and up to six image types to capture. MyOrthodontist will then prompt users if 
they want to submit photos to the practice, and a wizard will guide them through this process. 

• We made some improvements in AnywhereDolphin integration to check if a Dolphin user is or is not 
already and AnywhereDolphin user. 

• The patient phone number is now mapped to the patient chart when a patient is added using New Patient 
Online Forms. 

Document Organizer 
• You can now paste in the main Documents screen when the custom folder is enabled. 
• The drop-down list  in DDO is visible to employees with administrator rights only.  

Edit Menu 
• You can now access Quick Notes setup directly from the Edit menu: EditGeneralQuick Notes opens the 

new Quick Notes dialog box.  Use the Quick Note Type drop-down menu to select the type of quick note 
you want to add, edit, clone, delete, import, or export. You can navigate to the following types of Quick 
Notes from this new dialog box: Patient Comment, Chat Message, Day, Insurance Claim, and Letter. 
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• We have improved the way you set up treatment types. 
We added a new Proposals tab to the 
Add/Edit a Treatment Type screen, 
which enables you to associate one to 
four contract proposals with each 
treatment type. 
• We provide 3 images from which you 
can select as well as a Custom option, so 
you can import your own image to 
associate with a treatment type. 
• You can link the treatment type to up 
to four pre-defined treatment proposal 
templates. This way you can 
automatically generate contract 
proposals whenever you use this 
treatment type for a new treatment 
proposal. 
• On this tab you can set up the 
maximum number of months you can 
choose from when setting up a contract 

for this treatment type. (Max Finance Term (Mos).  

• For automatic down payment discounts, you can set the starting threshold based upon a percentage or 
a fixed dollar amount of the patient portion due (Discount Threshold Type).  

• (For discounts based upon a percentage), the percentage can apply to the Gross Treatment Fee, the 
Expected Patient Portion (default), or the Net Treatment Fee (% Discounts Apply To) 

• In the Down Payments list box, you add discounts that apply based upon the Discount Threshold Type, 
and you specify when this discount starts. For example, does it start when you enter a down payment 
equal to 10 percent of the patient portion, or a when you enter a fixed amount of $250 or more? 

• We changed the name of the Treatment Proposal Template Editor dialog box to Contract Proposal Editor, 
because that more accurately reflects its use.  You access it through the EditFinancial menuContract 
Proposal Templates. 

• The new Options button opens a screen where you can select a letter to associate with each contract 
option. We have included 3 sample letters for this purpose. 

• We added a new field type, 3rd-Party Integration, for User Defined Fields Setup. This enables you to set up 
and launch a 3rd party integration from within Dolphin Management, wherever custom fields are used – 
currently Edit a Patient and Edit a Doctor, Custom tab and the Treatment Card header. 

EditGeneralCustom Fields 

When you set up this field type, you specify either a URL to a 3rd party’s website or the full path to an 
executable on a network drive. A Parameters field is available for you add command-line options to a 
program or a querystring for a website. 
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• We widened the Patient Status drop-down menu on the Edit a PatientStatus tab. 
• We improved schedule templates: 

• You can now specify which days of the week each practice 
location  is normally open for scheduling via the Normal 
Schedule Days option. The default is Monday through 
Friday. 

EditPracticeLocationsEdit a Location dialog 
boxScheduling tab 

• When you apply a template to one of your practice 
locations, the Apply Template dialog box now has a new 
button: Apply Location Defaults, which will automatically 
apply the [Closed] template to any days not checked as 
Normal Schedule Days. 

EditSchedule Templates-->Apply buttonApply 
Template screen 

• The Postal Codes dialog box is now the Countries, States/Provinces and Postal Codes dialog box with 3 
separate tabs: Countries, States/Provinces, and Postal Codes. The Postal Codes tab matches what was on 
the Postal Codes dialog box in the previous release.  

EditGeneralCountries, States/Provinces and Postal Codes 

• We added a new button to the Tooth Numbering System screen: Set All Employees. When you click this 
button, a message pops up asking if you want to set this tooth numbering system to all employees. 

• New employees can be added by employees with administrator rights only. 
• You can now set the Maximum password age (days) field to a number higher than 50. 

EditPracticePassword and Login Setup 

• We added a new option, Enable Facial Recognition (Dolphin Mobile), to support a new facial recognition 
sign-in feature coming up in Dolphin Mobile V6 

EditPracticeLocationsEdit a LocationOptions buttonSign-In tab 

You can turn this feature off for specific patients on the Edit a Patient, Patient (more) tab. 

Email 
• For our Australian customers, we added a new option from the Ledger to email a “charge receipt.” This 

enables practices to email invoices that are labeled as invoices rather than as receipts.  
• We improved the way we set up Email accounts: 

• You can now associate practice locations to employee email accounts 
• You can create a default email account to use as a fall back for employees with no email set up. 
• Once an employee has his or her own email account, the default email account is no longer used for 

that employee. 
• An employee with administrator permissions can create an email account for another employee. 
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• You can copy a current email account 
• You can filter email accounts by location and/or by employee. 

EditCommunicationEmail Account Setup 

• You can now specify text for HTML hyperlinks rather than the URL for the following link-based letter tokens 
used in HTML-formatted emails: 

• Online Questionnaires 
• Secure Letter/Document 
• Confirm Appointment 
• AnywhereDolphin Generic Invitation 
• AnywhereDolphin Billing Party Invitation 
• AnywhereDolphin Doctor Invitation 

If your practice is licensed for Dolphin MyOrthodontist: 

• MyOrthodontist Generic Invitation 
• MyOrthodontist Patient Invitation 
• MyOrthodontist Billing Party Invitation 

EditCommunicationEmail TemplatesOptions tab 

Financials 
• We now warn you when you attempt to open a ledger if: 

• The patient  is missing an assigned location or is assigned to a deleted location 
• The patient record does not have an assigned provider, or the provider assigned has been deleted. 

• When you post an adjustment to decrease total due, you must choose the adjustment type, or it defaults 
to blank. 

• We implemented support for OpenEdge Decline Minimizer for one-time/Point-of-service transactions with 
EdgeLink Cloud integration. Previously this was implemented for recurring payments only. 

• We now populate the billing party name and address associated with the cardholder when posting debit 
transactions manually using PayWithBreeze integration. 

Insurance 
• You can now copy subscriber information from a billing party, related patient’s insurance policy or a 

patient: 

From the Edit a Patient dialog box, Insurance tab, Subscriber sub-tab, click the lookup button next to the 
Name field. This opens a new selection screen where you can choose from where you want to copy the 
insurance subscriber information. 
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• We changed the Insurance Treating and Billing Claim Information screen. Now before you exit that screen, 

we prompt you if you would like to apply changes to any current claims in status New. 
• For our Canadian customers we made the following label changes: 

• CDA ID field instead of the NPI # field on the Edit a Location, Address tab 
• CDA Provider Numbers group box instead of NPI Numbers group box on the on the Edit an Employee, 

IDs tab 

• For our Canadian customers, we built in a new check for patients that have more than one insurance policy. 
The primary subscriber must have a birthday month and day earlier than the birthday of the secondary 
subscriber. This data is pulled from the Subscriber tab on the Insurance Policy screen. 

• When you load data on the Insurance Claims screen, Dolphin opens a warning message if any new or 
pending claims listed break this rule, and the message prompts you to view and fix these claims. All 
claims that break this rule will then be displayed on the screen, regardless of the search filters used on 
the main Insurance Claims screen.  

• When you save a new insurance policy for a patient that already has at least one policy, Dolphin checks 
if this rule is satisfied, and if it is not, provides you with an opportunity to change the  primary 
subscriber. 

Ledger 
• At a customer request, we added a TX Card button between the Patient and Appts buttons on the Ledger 

tool bar. 
• The pop-up message that is displayed when changing a patient’s normal location has been changed to 

more accurately reflect how this will affect the patient ledger. The message now reads:  

“You are attempting to change this patient's normal location for …  We will write a 'location change' ledger 
transaction to document that the balance was transferred to the new location.  Previous transactions will 
remain tied to the original location and all new transactions will be tied to the new location.  Do you wish 
to continue?” 
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Letters 
• As part of the orthodontic treatment/contract proposal enhancement, we made the following changes in 

the Letters queue and Add Letter features: 

• We added three sample letters: 

• DM – Tx Proposal – 1 option (Sample).doc 
• DM – Tx Proposal 2 Options (Sample).doc 
• DM – Tx Proposal 3 Options (Sample).doc 

• From the Patient Treatment/Contract Proposals screen, the Print Proposal button opens the Add 
Letter dialog box. There is a new option, View Letter After Adding To Batch, which, when checked, 
opens the Letters queue and merges just that letter, so you can view it. 

• The Add Letter dialog box now includes an optional field Contract (Proposed). If you leave this field 
blank, you can print a proposal for several contracts; if you select one contract; that is the only contract 
proposal that is printed. 

• The Letters queue now includes a Refresh button, which you can use to show all letters in the queue, 
not just the treatment proposal letter.   

• The Tables tab in the Dolphin Fields dialog box now has two radio buttons - Horizontal and Vertical -
from which you can choose to define the table layout. 

• We added a new table type to the Tables tab in the Dolphin Fields dialog  box: Proposal Contract 
Regular Charges, which includes two new columns: ContractProposalPaymentAmount and 
ContractProposalRunningPaymentTotal for use in treatment proposal letters. 

• When you delete a letter from the Letters queue, the letter is removed from the queue without the queue 
having to be refreshed 

• We added a letter token for patient school information: PatientSchoolName. 
• We added the UserSignature letter token, which merges the signature on file of the employee logged in at 

the time a letter is merged and printed. 
• We added the TreatmentProposalTypeDescription token, which merges to the Description/Narrative field 

on the Add/Edit a Treatment Type dialog box, Proposals tab. 
• You can now right-click a letter and send it directly to the DDO (Send Letter to DDO). If the letter is in 

status New, it will complete the merge and then send it to the DDO. If the letter is in any status other than 
New, the changes are merged, and the letter is sent to the DDO. 

Light Bar Full Screen 
The Light Bar Full Screen now honors the standard light bar options to show patient ID, patient name, and 
appointment type code. 

Patient Information 
• After you add a new patient, specify the minimum information required (Patient name, billing party name, 

location, and orthodontist) the new Where to Go Next pop-up screen appears, so you can quickly navigate 
to one of the following: 
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Dolphin remembers the choices made per user, and each user can opt to skip this pop-up screen, and 
instead always navigate to their saved choice. 

Click the new Options button on the Add a Patient screen to reopen the Where to Go Next screen if you 
want to see it again. 
 

• You can now add Quick Note comments from the Add a Patient dialog box. This new feature replaces one 
of  the two New Patient Reminder(s) text boxes that previously appeared at the bottom of that screen. 

• You can now see a patient’s status as soon as you open Edit a Patient. We added a patient status header to 
the upper-right of the Edit a Patient, Patient tab. Click this button to go directly to the Status tab. 

• We improved the View drop-down menu on the Edit a Patient, History tab so you can filter on all or any 
combination of history events you select. 

• The Performed column on the Edit a Patient, Appointments tab, which remains hidden unless the check 
boxes, Past and Today’s are checked, now retains its default width when it is shown. 

• We improved the way you add treatment and contract proposals on the Edit a Patient, Fees tab, and you 

can now access the treatment proposal feature from the Main icon bar  button See 
Treatment Proposals for more information and a link to a getting started document. 

• We no longer prompt if you want to add a new insurance policy (Insurance tab) if this is the first insurance 
policy for a new patient. We also no longer prompt to add a new fee (Fees tab) if this is the first fee for a 
new patient. 

• We added a new field on the Edit a Patient, Patient (more) tab to support the upcoming Dolphin Mobile v6 
facial recognition feature. The new field Disable facial recognition sign-in gives you the option to make the 
patient sign in using one of the other sign-in methods. 

• When an employee is added as a referral source for a new patient, other employees cannot view that 
employee’s chart or documents unless they have administrator rights. 
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Reports 
• Dolphin Interactive Report Tool 

• We added a Print Options tab (shown below), where you can specify page orientation, size, unit of 
measure, and print margins. You can also hide the column name associated with the group total 
average and/or count in the group footer and disable alternating row colors. 

 
• We added the following fields under Patient report category, Financial Fields field category: 

• Patient Has Recurring Payments, which returns Yes or No if there are unposted recurring payments 
on a started contract. 

• Patient Has Payment Plan, which returns Yes or No if there are unposted payments on a payment 
plan. 

• We added the following fields under Patient report category, Patient Insurance field category: 

• Is Primary 
• Is Secondary 
• Accept Assignment 
• Continuation Frequency 
• Pre-determination Form Required 
• Initial Form Required 
• Continuation Forms Required 

• We added the following fields under Patient report category, Patient Current Status field category: 

• Patient's Current Status Start Date 
• Patient's Actual Months in Status 
• Patient's Months Remaining to Estimated Completion 
• Patient's Percent to Estimated Completion 
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• You can now send mass correspondence to the default doctor assigned to each patient. Drag one of the 
Default Doctor fields into the report, and that doctor will be a selectable addressee. 

• We enhanced the right-click  Column FunctionShow only the first occurrence sort option to include 
by Patient, by Billing Party, by Doctor, and by Employee. Using this feature, for example, you can send 
a single mass message to all billing parties tied to patients by choosing to show only the first 
occurrence of the billing party’s email address. Previously, duplicate messages would be generated in 
cases where a billing party email was associated with more than one patient. 

• We made the following changes to the Hummingbird reports: 

• We added three new custom DIRT reports: 

• Patients in Status - New Patient Added with No Next Proc Date 

A list of patients in status New Patient Added, with no future appointment 

• Patients in Status - New Patient Added With Next Proc Date 

A list of patients in status New Patient Added with a future appointment 

• Patient Status - Active Phase I to Inactive 

A list of patients who went from Active Phase I status to Inactive without being placed in Phase II 

• We removed the Consults Needed/Scheduled Statuses from the Hummingbird Setup, Categories tab 
and the corresponding DIRT report, Patient Is In Consults Needed/Scheduled Status. 

• We added a new option on the Print Report screen for non-administrator users: Show reports I don’t have 
rights to run, which is not checked by default. When checked all reports are listed, but those  which the 
logged-in user cannot run are denoted with an asterisk. 

Schedule 
• When you search the schedule and specify a location, the search now defaults to that location’s open days. 
• The account balance tooltips now exclude insurance ledgers from the calculation shown. 
• Dolphin Management no longer prompts you to confirm after you cancel a light bar status change. If you 

would like to be prompted, simply click the new Prompt to confirm light status change cancellations check 
box on the Light Bar Setup screen. 

EditSchedulingLight Bar Setup 

 
• We made performance enhancements to Scheduling: 

• The Schedule tab will not reload when an appointment’s status changes unless the date on the 
Schedule tab matches the date of the appointment. 

• When the Scheduling screen is open, but covered by other screens and apps, GPS appointment 
updates are queued until the Scheduling screen is brought to the foreground. The updates are 
processed in one batch. 

• We optimized the Needs Appointment tab on the schedule widget to improve performance and reduce 
server load. 
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• You can control which schedule widgets (the tabs below the Calendar widget on the right-side of the 

Scheduling screen) to show per computer. From Scheduling, select OptionsSelect schedule widgets to 
show: 

 
All options are selected by default except for Needs Appointment, which is the most resource intensive.  
 

• You can now add the patient’s birthdate (month and day)  to Patient GPS: 

Patient GPSSetup  buttonColumns tabAvailable Columns list box. 

• When you add a block notes (day notes that 
have start and end times associated with them) 
to the schedule, you can now choose one or 
more columns/chairs to which to apply the note. 
Once you specify a start time and end time on 
the Day Note dialog box, two new tabs appear: 

• Block Note 
• Columns 

Choose one or more schedule columns 
where you want the block note to appear. If 
you select all columns or no columns, the 
block note will cover all columns. If you select some columns, the note is either repeated in each 
column or it is repeated across each contiguous section of columns.  

• We enhanced the ability to show or hide doctor information on schedule columns when viewing a day with 
provider reservations templated: 
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• If the schedule day you are viewing uses a template with provider reservations, the Reservations tool-
bar button changes into a drop-down with two options: 

• Show Appointment Type/Class Reservations 
• Show Provider Reservations 
You can choose one or both options, and Dolphin remembers the choice per user. 

• If the schedule day you are viewing is not using a template with provider reservations, the Reservations 
button works the way it did in previous releases: it simply toggles the display of the reservation 
information on or off. 

• When you schedule a new appointment or open the Appointment information screen, and check Sooner if 
Possible, a new field, Not Before appears. Use this field to select a date before which Dolphin will not offer 
an earlier schedule option.  This field is optional, and if a Next Visit entry exists in the treatment card, that 
date is automatically populated in this field. 

Scheduled Job Manager 
• We enhanced the Setup options for the Automated Email Messages and Automated SMS Messages 

scheduled jobs. The Report Field group box Days Before To Send field has been redesigned so you can 
select the number of days before or after which you want to send the email or SMS message. 

 
If you choose After, you could send a follow-up email or message after a patient’s last appointment or 
entry into  a certain patient status, for example. 

Super Questionnaire 
• You can automatically generate alerts based on answers in Super Questionnaire. You specify the alert type 

to associate with any multi-select, single-select, or drop-down question type. 

The Add Answer dialog box now includes an Alert Type pull-down list, where you can select the type of 
alert to associate with each answer. For an alert type to be included in this list, it must be defined with the 
following rules, which you access via EditGeneralAlert TypesAlert Type screen, Rules tab: 
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• Patient Selection Optional or Required 
• Billing Party Selection: Disabled, Optional, or 

Required. 
• Employee Selection: Disabled 
• Duration Selection: Neither Task nor Date-

Based or Task 

For existing Super Questionnaires, you can 
associate an alert with any answers to the 
question types listed above.  Simply right-click on 
an answer in the Answers group box and click Set 
Alert Type to open the Alert Type Info dialog box, 
or mouse over and select from one of the alert 
types in the drop-down list. 

From the Alert Type Info 
dialog box, you can change 
the Selected alert type 
associated with the answer 
you selected. 

You can have one of each alert 
type per question only. 

Alerts generated by Super 
Questionnaires will show in 
the Alerts group box, on 
screens where the patient is in 
context, depending upon how 
you defined the rules on the 
Alert Type, Rules tab.  
 

For example, if the Patient 
Selection rule is Optional or Required, the alert will show where the patient is in context, such as 
Treatment Card, providing the billing party rule is set to disabled or optional. 
 

If you set the Billing Party Selection to Required, then the alert will show only where both the billing party 
and patient are in context, such as on the Ledger screen. If you set the Billing Party Selection to Optional or 
Disabled, the alert will show anywhere the patient is in context, such as the Treatment Card or Edit a 
Patient screens. 
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•  When you send a super questionnaire to the DDO, it is now stored there with the name of the actual 

questionnaire. 

Treatment Card 
• You can now import and export Quick Notes for treatment card fields. If you select a field type (such as 

Text, Custom Lookup, etc.) that supports lookup items, the Export and Import buttons now appear on the 
Lookup Items tab. Note that dynamic, question/answer quick notes cannot be imported to field type 
Database Lookup, though standard notes can. 
 
EditTreatment Card SetupFields tabTreatment Card FieldLookup Items tab 
 

• We made the following change to Patient Analysis: 

• On the Practice tab, Total Fee has been replaced with Gross Fee and Net Fee. 
• The Fee per Hour, Estimated Fee per Month, and Estimated Fee per Visit calculations are based on the 

Net Fee. 

Treatment CardAnalysis buttonPatient Analysis screenPractice tab 

• The Questionnaire button now opens a drop-down list of questionnaires completed or in progress for  a 
patient. If no questionnaires currently exist, a single click on the Questionnaire button opens the 
Questionnaire or Super Questionnaire dialog box. 

• We improved load speed performance when the Load All Entries option is not selected.  
• When Load All Entries is not selected, the 10 most recent entries on each treatment card layout now load 

rather than the 10 most recent entries across all treatment card layouts. 
• Column size changes are now saved as soon as you make them rather than after you click the OK or Save 

buttons. 
• You can no longer use the Set Field Color option on Comment entries. 
• The Treatment Card Layout drop-down field on the Treatment Plan, Treatment Card tab now defaults to 

the last selected treatment card layout rather than the first layout in the drop-down menu. This occurs 
when you switch between planned items with no treatment card field defaults defined. 
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Treatment Proposals 

• You can now access the new Treatment Proposal feature via the Main icon pane, button as 
well as from the Edit a Patient, Fees tab, Proposal sub-tab. When accessed from the Main icon pane, you 
are prompted to select a patient before continuing. 

The following paragraphs describe this new feature in detail. If you want to get started using this feature, 
click on this link for Step-by-Step instructions from our Dolphin Training team. 

• You are immediately prompted to select a treatment type as soon as you click the <Add Proposal> 
button on the Edit a Patient, Fees tab, Proposal sub-tab. Once you select the treatment type, the New 
Treatment Proposal window opens 
with the following fields completed 
based on that selection: 

• Treatment Type 
• Estimated Treatment Months  
• Gross Treatment Fee 
• Expected Insurance Benefit. 
• Billing Party and Insurance 

Policy (provided Accept 
Assignment and Show Ledger 
were selected on the Insurance 
tab, Policy Options sub tab) 

You can modify any of these fields, and then click OK to have that information completed on the new 
proposal. 

• A default contract is set up for you based on your selections to the new prompts, so you do not have to 
click <Add Contract Proposal>.  

• Once you have one or more contract options on the Fees tab, Proposed sub-tab, you have the option 
to print the proposals or display them on your screen, via the new Print Proposal and Present Proposal 
buttons. 

On the Present Proposal screen, shown below, Contract Option A is preselected. You can change the 
down payment amount, number of payments, or monthly payment on this page (using the sliders) to 
show your patient/billing party various options. When you first open this screen, the monthly payment 
amount is locked by default. If you lock the number of payments slider, the monthly payment slider is 
unlocked, as shown below. 

https://www.dolphinimaging.com/Areas/Product/Documents/Management/Management_TreatmentProposal.pdf
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• When you add a treatment on the Edit a Patient, Fees tab, Actual sub-tab, and you had previously added 

one or more treatment/contract proposals, the Contract Proposals list box opens so you can choose which 
proposal you want to add. You can cancel out of this list box if you want to set up a new treatment for 
which there was no proposal. 

 
• Any itemized charges are displayed as collapsed by default when you open an existing contract proposal or 

apply a template to a contract proposal. 
• Whenever a down payment discount is applied to a proposal, we store that number, so in case a patient 

signs a treatment proposal, and that discount is then modified, we keep the original number. In the case 
where the down payment discount threshold changes, we prompt the user whether he or she wants to 
accept the new number prior to converting the proposal to a real treatment contract. 
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Specialty Module – V 10.1 
Available in this release is the Dolphin Management Specialty Module, which supports pediatric dentistry and 
multiple specialty practices (pediatric dentistry and orthodontics for example).   

Dental Tooth Chart 
• We increased the field size for Quick Note Templates 

from 6,000 to 8,000 characters when used for dental 
conditions in the Dental Chart Setup.  

Edit—>TreatmentDental Chart SetupConditions 
tab, Button ItemsAdd Condition Details group box, 
Quick Note tabEdit 

• The tooth chart now supports labels for codes and 
conditions.  

In the Dental Chart Setup screen, Draw Style group box 
for both Codes and Conditions, there is a Label field. 
Enter text in this field to have it drawn to fit inside the 
filled tooth area corresponding to the code or condition.  

For example, if you enter  “S” for a sealant code, Dolphin 
renders an “S” inside any surface(s) selected for that 
code performed or planned on a tooth. 

• We now support selecting and unselecting a tooth on 
the Dental Treatment tooth chart. 

• We made the following changes to Draw Style for codes and conditions: 

• The Tooth Model field defaults to Crown and Root; other options will be available in future 
enhancements. 

• There is a new Fill Type drop-down field, where you can specify how the tooth should be filled: 

• Tooth or Surface (Fill the entire tooth or selected surfaces only, if any are selected for the code or 
condition) 
We set this as the default for all pre-existing conditions and all codes that have the word tooth 
and/or surface in the description. 

• Crown Only 
We set this as the default for all codes that have the word crown in the description 

• Root Canal 
• Root Tip 
• Gingival Margin 
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• You can now add, edit, import, export, and delete conditions, and we now include a set of default 
conditions: 

 

EditTreatmentDental Chart SetupConditions tab 

• We support Quick Notes when editing or adding  button items to Dental Tooth Chart Conditions. 

EditTreatmentDental Chart SetupConditions tabButton ItemsItemsAdd 

Quick Notes are described in the standard Dolphin Management online help, and in this document, in 
Quick Notes under the section: New Management Features in 10.0. 

When adding a treatment card entry, Dolphin prompts you to complete the quick note. 

Dental Treatment 
• You can now visualize the procedures on the dental tooth chart when adding charges/codes. 
• You can now select multiple teeth (Shift+Click) while adding charges  to the charge grid, and a line item for 

each selected tooth is added to the grid. 
• Procedure and condition colors on the Dental Treatment screen now layer over one another in the order 

applied. We have colors for Past Procedures, Current Procedures, Planned Procedures, and Conditions. 
• The Dental Treatment screen now shows all patient conditions up to the current visit entry. 

Overrides 
You can now set up overrides (either downgrades or upgrades) when setting up an employer plan, provided 
you have added the codes you want associated with the downgrade or upgrade to the Fee Schedule. Once you 
set up an override, you can see it when you post a charge, write off the difference, or charge the patient the 
difference based on what the employer plan allows. 
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To access this new feature: EditFinancialEmployersEdit an EmployerEmployer Plans tabDental 
Benefits sub-tabOverrides buttonEdit Overrides button. 

Once in edit mode, you must specify a value greater than 0 for the Override Amount. If the employer plan 
allows you to charge the difference to the patient, click the Charge Patient  check box.  

When you post a charge, Dolphin checks if there is a downgrade, and if there is, the most you can charge the 
insurance is the downgrade amount. The difference between the downgrade amount and your standard 
amount is either charged to the patient/billing party (if allowed by the insurance plan), or written off, along 
with the difference between your standard amount and the contracted amount.  

The Insurance Worksheet, which you can access from the Post a Charge dialog box, now includes override 
information, as shown in the following example: 

 
In this example, the worksheet shows ($5.00) as the downgraded amount on the Downgraded By row because 
the insurance plan allows the practice to charge the difference to the patient. If the Charge Patient check box 
had not been checked, the Downgraded By row would not show because that amount would automatically be 
included in the Base Insurance Amount. 
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Edit Menu 
• We added a Dentition Rule field that you can apply when tooth selection is required or optional for a 

charge code. 

EditFinancialChargesAdd a ChargeCodes tabEdit CodeCharge Code screenDentition Rule 
field. 

The options are: 

• Permanent or Deciduous - either permanent/adult or deciduous/primary teeth can be selected 
• Permanent Only - only permanent/adult teeth may be selected 
• Deciduous Only - only deciduous/primary teeth may be selected 

Help Menu 
To access online help for the Specialty Module, from the Help menu, select Specialty Module Help. 

Treatment Card 
• If you have multiple treatment card layouts and two or more have Proposed entries, when you right-click to 

access the Create Treatment Proposal from Treatment Card Entries screen, you will now see tabs 
representing each treatment card layout. The active tab corresponds to the layout you were on when you 
accessed the right-click menu, and this is the tab that will print when you click the Print button. 

• When you check out a patient, the Check Out wizard now shows a Proposals button if that patient has 
treatment proposals on his or her treatment card. 

Click the Proposals button to open Treatment Proposals, so the patient/billing party can review them. 
Once you mark a proposed item as accepted, the Proposed entry is immediately converted to a Next Visit 
entry on the patient’s treatment card. 

• After you have added a Proposed entry on a patient’s treatment card, and right-click to access the Create 
Treatment Proposal from Treatment Card Entries screen, we now prompt you if you make changes, and 
click OK without clicking the Print button: 

“You have changed some statuses and have not printed. Would you like to print a copy to the DDO first?” 

• We made the following specialty-specific change to Patient Analysis: 

• You can now filter data based on the new Specialty filter. 
• The specialty assigned to the current treatment card layout in use is selected by default when you open 

Patient Analysis. 
• You can also use the new Specialty filter all counts on the Patient tab, including an <All> option, to see 

counts across all specialties. 

Reports 
• You can now track discounts through DIRT with the following new fields: 

• In the Billing Party field category: 

• Billing Party's Dental Percentage 
• Billing Party's Dental Discount Description 
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• Billing Party's Dental Discount Code 
• Billing Party's Dental Discount Is Setup 

• In the Default Billing Party field category: 

• Default Billing Party's Dental Percentage 
• Default Billing Party's Dental Discount Description 
• Default Billing Party's Dental Discount Code 
• Default Billing Party's Dental Discount Is Setup 

• We added the following DIRT fields for specialty patients in the Schedule Charge field category: 

• Schedule Charge Discount Amount 
• Schedule Charge Sum of Charge – Discount Adjustment 
• Schedule Charge Treatment Discount Code 
• Schedule Charge Treatment Discount Description 

• We added the Benefit Period Start Date field in in the Patient Insurance field category. 
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New Management Features in 10.0 

Global 
• You can now create a per-user, customized Icon Pane. From any of the available Icon Panes, simply right-

click a button (such as Patients, for example), and select Add To Favorites.  
 
 
 
After you add your first button, a new Favorites button is added to the 
Icon Pane, and this opens by default when you log into Dolphin 
Management.  
 

You can continue adding as many buttons to Favorites as you want; these 
buttons remain accessible from their original 
location also. 
 
 
 
 
 
 
You can reorganize the buttons in Favorites, and 
you can have as few or as many buttons as you 
need. If you remove all the buttons from Favorites, 
the Favorites button goes away, and the Main icon 
pane opens when you log into Dolphin.  
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• Based on responses from several Dolphin customers, we have added some color back into the icons and 
several places throughout the product, as shown in this Treatment Card screen shot below: 

 
 

Quick Notes 
• We have added the ability to set up and use quick notes across many areas of the product, and we will 

continue to add this to other areas as customers request it. 

You can set up two kinds of quick notes in Dolphin Management: 

• Simple, text phrases that you can pick from and add to a treatment card comment, a schedule day 
note, or a quick letter note.  

• A template that consists of one or more question/answer pairs that cover common topics you might log 
in a treatment card comment, schedule day note, or quick letter note. 

Additionally, you can export and import both kinds of quick notes from and to your practice, and you 
can clone a quick-note, enabling you to use the copy as a starting point for a new quick note. 

Both simple text lookups and quick notes are available: 

• EditCommunicationQuick Letter Notes 
• EditTreatmentTreatment Card SetupAdd/Edit a Treatment Card LayoutQuick Comments 

tab 
• Chat Message ViewerOptionsQuick Message Setup 
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• Letters dialog boxOptionsSetup Quick Letter Notes 
• Schedule dialog boxDay Notes buttonOptions—Setup Quick Day Notes 
• Treatment CardNotes tabUnlockLookup 
• Treatment PlanNotes tabUnlockLookup 
• Patient CommentsOptionsSetup Quick Patient Comments 
• Insurance ClaimsOptionsSetup Quick Insurance Claim Notes 
• Insurance Claim (Insurance ClaimsEdit a claim), General tab, Printed Paper Comment and Full 

Electronic Comment (Non Transmitted) list boxes 

These are described in more detail in the online help. 

• When entering quick notes, you can now switch between a new list-style wizard and the standard wizard, 
via a new Switch button. The list-style wizard does not have the Next or Previous buttons, but it has a scroll 
bar, so you can view all the questions, in the case of a multiple-question template. The Start Over and 
Finish buttons are available on the list-style wizard. 

• At a customer’s request, we enhanced the database log to honor the setting for ServerTimeOffsetMinutes 
in the Dolphin.INI file 

Analysis 
• When you resize columns in a Practice Analysis itemized view, the rows resize to fit the cell content. We 

also added an Autosize toolbar button to itemized views. 
 
• For customers using the Hummingbird module: 

• the following new columns are available on Gross Charges, Balance Adjustments, Gross Collections 
(Payments), and Collection Adjustment sub-queries: 

• Ledg. Adjustment Number 
• Ledg. Date Time 
• Ledg. Serv Code 
• Ledg. Transt Code 

To access these options, load the Hummingbird Analysis view, and double-click in the Total column 
associated with the sub-query you want to view.  

When the Financial Information query loads, you can click the Fields button to open a list of available 
columns. The new columns will appear in the Available Fields list box. 

• Amount is now one of the default fields you see when opening any of the Financial Information items 
on the Practice Analysis, Hummingbird Analysis view. 

AnywhereDolphin/MyOrthodontist Integration 
• We replaced the Defaults tab with two new tabs: Templates and Permissions. 

The Templates tab contains the AnywhereDolphin invitation, questionnaire and add or update user name 
templates previously found on the Defaults tab. 
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The Permissions tab contains the default items to share fields previously found on the Defaults tab, plus 
some new fields as well: 

 
All billing parties can new view and update patient demographics only if the View Patient 
Demographics and Update Patient Demographics fields are checked. There is also a new option to 
remove billing party access to these and all other patient fields (Financial Balance and Financial Ledger 
excepted)  after the patient reaches 18 years or whatever age the practice specifies. 

There is  a separate set of patient access permissions now as well. 

• When you click the My Orthodontist/AnywhereDolphin button while on the Edit a Patient, Billing Parties 
tab, the MyOrthodontist/AnywhereDolphin User Settings dialog box will default to the billing party 
account. 

Care Calls 
There is now an Add button in the Notes section of the Care Call dialog box. Click this button to add a date and 
time stamp to the Notes field, and place the cursor on the line below the stamp. 

Chat Message Viewer 
• We added the Regarding Patient filter to the criteria, so you can view messages pertaining to a particular 

patient. 
• There is a now a Regarding Patient lookup on the Send Message and Reply screens. When you send or 

respond to a message regarding a patient, you can right-click on it and access the standard patient context 
menu. 

• We added a Quick Message button to the Send Message and Reply screens. Click this to access quick notes 
you can add to the chat message. 

• We added an Options tool bar button with the following drop-down choices: 
• Show incoming messages on top of other applications—when this per-computer option is activated, 

any incoming chat messages pop-up outside of Dolphin Management, and they open on top of other 
running applications. 
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• Quick Message Setup—opens the Quick Chat Message Note screen, where you can configure both 
kinds of quick notes for inserting into chat messages. 

Document Organizer 
• There is a new Options button on the Scanned Documents screen, which gives you the option to set the 

PDF page size: 
 
• US Letter (the default setting) 
• US Legal 
• A4 
• Tabloid 
• Junior Letter 

This is a global practice setting. 

• When you attempt to save a folder template without selecting an option on the Applied to Record Types 
tab, we now prompt you to select one. We do not allow you to create a folder template without selecting a 
record type. 

• We added  button to the Documents toolbar. Click this to access the Signature Queue 
dialog box where you can search for documents in the system requiring signature, such as treatment 
proposals and questionnaires. You can also access the Signature Queue from the Main menu. 
 
You can right-click on a document in the Signature Queue, and access the patient context menu, for patient 
letters. You can also select from one of the following options: Sign Document, Open DDO Folder, View 
Document, or Remove from Queue. 
 
You can also view the document, by selecting it, and clicking the View button on the Signature Queue 
toolbar. 
 
If you practice is licensed for MyOrthodontist, you can share the document with the billing party and/or 
patient, he or she can sign it through MyOrthodontist, and it will be updated in the Document Organizer. In 
the case where the doctor or another staff member needs to sign the document, the document is saved 
and the latest version (the signed version) is shared with the patient/billing party only. 

When you sign (or partially sign, in the case where a billing party or patient has signed, but the doctor still 
needs to sign) a shared document, the Shared Documents tab is updated with the latest (signed) version of 
the document. 

Edit Menu  
• We added the option Default to use for SMS to the Phone Type dialog box. This gives practices a global 

way to define certain phone types, such as mobile, for example, to be used for sending SMS messages. 

Edit->CommunicationPhone Number, Type and Integration SetupPhone Types tab--<Add or Edit a 
phone type. 
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• We added the Practice Name field to the Edit a Doctor, Doctor tab. We also added a Doctor’s Practice 
Name field to the Doctors report category in DIRT as well as a corresponding letter token. 

• We added Groups and Non-Patients to the Edit->People cascade menu. 

• You can now create patient care teams (EditPatientPatient Teams) and distinguish them by name, 
description, and color. Each team can be associated with one or more locations. You add any number of 
employees to each care team. 

 
When you add a new patient, or edit an existing patient you now have the option to assign a team to that 
patient on the Patient (more) tab. 

 

 
The number in parentheses indicates the number of patients in that team. 
 

• The Past Due Messages tab (EditLocationsEdit a LocationOptions button) now has a custom 
Number of days past due field instead of the radio buttons for Over 30, Over 60, and Over 90. Use this field 
to customize how many days past due triggers a message at patient sign-in. 

• We added the ability to associate a default contract proposal template with a treatment type 
(EditFinancialTreatment TypesDefault Contract Proposal look-up field) 

• We added the ability to associate customized appointment reminder and scheduled messages with 
appointment types. For example, for a bonding appointment type, you may want to use an SMS or Email 
template that mentions that fact. Or you can use the default, Dolphin-supplied global default templates. 
With this new feature, you can: 

• Add new templates to use for specific appointment types. 
• Edit the default templates used for all appointment types. 
• Disable automatic sending of reminder SMS message, Scheduled SMS message, Reminder Email, and 

Scheduled Email or any combination of the above, based on the appointment type. 

1. From the Edit menu, select SchedulingAppointment Types.  

2. Select any appointment type to edit, and click the new Reminder/Scheduled Templates tab. 

 
3. Click Edit to edit any of the Default templates above. 

This opens the SMS Templates dialog box or Email Templates dialog box where you can edit Dolphin-
supplied default templates, or add new templates specific to your practice, same as in the previous 
release. 
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After you have added a new template or edited an existing template, select it, and click OK on the SMS 
or Email Templates dialog box, and it is added to the Reminder/Scheduled Templates tab on Edit an 
Appointment Type, as shown above. 

• We removed the Waiting tab, previously on the Edit a Location Options dialog box  
(EditPracticeLocationsOptions button) because Dolphin Management no longer uses most options 
there.  

We moved the Minutes until Priority option to the Sign In tab, and it has been renamed to Wait minutes 
until priority (red) in GPS, which is more descriptive. 

Employee Roles 
You can quickly create new or edit existing employee roles by copying the application and/or report rights from 
an employee to that role. You can then use that role to assign rights to new employees. 

EditPracticeEmployee Rolesadd/edit roleclick Copy From Employee button 

Email 
You can now request a read receipt for emails sent from your practice: 

• From an individual email, (Email Settings dialog box) check the new Request read receipt check box (not 
checked by default) in the lower left corner. 
This sends a read receipt request with this email only. 

• In the Email Account Options dialog box, there is now a checkbox (not checked by default), Request read 
receipt for all messages sent via this account.  
When you check this box, all email messages are sent with a read receipt regardless of the Request read 
receipt check box setting on the individual email. 

Financials 
• We added the Balances field and two radio buttons on the Checkout wizard. Select the By Patient radio 

button to view charges pertaining to the patient at checkout time. Select the By Billing Party (All Patients) 
to see all charges based on the billing party (who is responsible for more than one patient). Dolphin 
remembers the option selected per user. The second option enables you to see the balance for all patients 
associated with a billing party and collect the money at checkout time. 

• The Recurring Payments dialog box now includes a Send to DIRT toolbar button. Once the recurring 
payments list is sent to DIRT, you can filter, generate groups of outgoing letters, SMS, and email messages. 

• We improved the speed at which the End-of-Day job applies open payments and/or adjustments to charges. 
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• Our EdgeLink Cloud integration now works with OpenEdge Decline Minimizer when capturing funds for 
recurring payments. If the card number and/or card expiration date returns something other than what is 
on file for recurring payment transactions, Dolphin updates the card information with what it received from 
OpenEdge. 
 

• We now show the Choose Locations to Close dialog box when you have the System option, Enable One 
Step End of Day/Month activated and you have the System Option, Always Run EOD/EOM for All 
Locations activated. This way you can access the One Step End of Day option, which is on the Choose 
Locations to Close dialog box. 
 

• The Recurring Payments dialog box, Select button includes the following new options: 
• Select All Pending 
• Select All Approved 
• Select All Declined/Error 

Insurance 
• We added the Quick Notes feature to the Insurance Claims queue: 

Insurance ClaimsOptionsSetup Quick Insurance Claim Notes 

Once you have set up 
quick notes, you can 
access them and place 
them via the Quick Note 
button on the Insurance 
Claim dialog box, 
General tab, Printed 
Paper Comment and Full 
Electronic Comment 
(Not Transmitted) list 
boxes. 

• You now have the 
option to save an 
employee’s signature on 
file for insurance claims. 
From the Edit an 
Employee dialog box, 

select one of your providers, and add a signature for that doctor. When you print a claim, the words 
“signature on file” will appear on the box for the doctor’s signature. 

• The Procedure Code Type field on the Edit a Patient, Insurance tab, Other sub-tab now defaults to the 
value entered for the Default Code Type field on the Financial tab (ToolsOptionsFinancial). 

• You can automatically submit continuation claims based on time of service (TOS). Enabling this requires 
that you: 

• Check a new field on the Edit an Appointment Type dialog box: This Enqueues a TOS Ins Continuation 
Form for those appointment types you need. 
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• Select Time of Service for the Continuation Frequency field on Edit a Patient, Insurance tab, Other sub 

tab. 

Everything else works the same as 
normal claims: when the unbilled 
benefit amount reaches zero, no more 
automatic continuation claims are 
sent.  

When you dismiss an appointment 
type with the This Enqueues a TOS Ins 
Continuation Form field checked, the 
continuation claim is added to the 
insurance queue.  

You can also now filter the Insurance 
Claims queue by Time of Service Claims 

• We added an option, Hide Additional CDT Codes on Initial Claims to the Edit an Employer, Employer 
Plans, Plan tab. This is to address the need that some carriers must see itemized charges for their initial 
treatment fee, but not have CDT codes for other items appear on the Initial claim.  

• We added three new options to the Edit an Employer, Employer Plans, Plan tab: 

• Accept Assignment/Create Ledger  
• When checked, all insurance forms for this employer will be configured to accept assignment and 

Dolphin Management will create an insurance ledger. 
• If you have existing patients linked to this employer and you change this setting, Dolphin prompts you 

to update these to match the setting on the Employer Plans, Plan tab. 
• Show Accept Assignment on Forms 
• When checked, all insurance forms for this employer will show the accept assignment status. 
• Show Secondary/Other Ins on forms 
• When checked all insurance forms for this employer will show the fields for secondary or other 

insurance. 

Ledger 
• We added two new fields to the header on the billing party ledger: 

• Next Charge Date 
• Next Charge Amount 

 
If the next charge is a down payment, the two fields read: 

o Next Down Pmt Date 
o Next Down Pmt Amount 
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Additionally a progress bar appears above the Unbilled Contracts field, if a contract has been started 
for the selected billing party and patient. 

These fields are hidden if no next charges exist or down payments exist for the current ledger. 
 

• The tool tips for the payment plan and recurring payments icons now include next scheduled payment date 
and next payment amount. 

• When you print an FSA Statement from the Ledger (PrintPrint Flex Plan), For  Othodontics prints in the 
upper left.  

• We added an option, Print a Statement to the Print tool bar button. That opens a screen where you can 
specify which future contract charges you want to include on the printout. 

• We added a new Correspondence toolbar button to the Ledger dialog box with three options: Add Letter, 
Send SMS Message, and Send Email Message. If the patient has no SMS phone number or Email address 
on file, the Add Letter toolbar button appears instead of the Correspondence button. 

Letters  
 
• We added the following new letter tokens: 

• LastRecurringPaymentDate - the scheduled date of the last recurring payment (on or before today) 
• LastRecurringPaymentAmount - the amount of the last recurring payment (on or before today) 
• NextRecurringPaymentDate - the scheduled date of the next recurring payment (after today) 
• NextRecurringPaymentAmount - the amount of the next recurring payment (after today) 

These tokens return data for the selected patient or billing party, providing the recurring payment is 
associated with a started contract or configured as a stand-alone payment plan with no associated 
contract. If the patient or billing party has more than one contract, these tokens still return the date of 
the closest recurring payment, regardless of the treatment or contract selected. 

• We added the following new letter tokens to use in SMS and Email appointment reminders and 
appointment scheduled templates: 

• AppointmentLocationCity – the city associated with the appointment’s assigned location 
• AppointmentLocationPhoneNumber - the first phone number associated with the appointment’s 

assigned location 
• AppointmentLocationSmsNumber - the first phone number that is marked "Use for SMS" for the 

appointment’s assigned location 

• We now prompt you if you want to add a doctor as a referral out for a patient if you add a letter regarding 
a patient to a doctor who is currently not a referral out for that patient. If you choose to do so and the 
patient has no other doctors listed, this doctor becomes the default referral out for this patient. 

• We added two ways to access quick notes (described under Global) from letters: 

• EditCommunicationsQuick Letter Notes 
• From the Letters dialog box, OptionsSetup Quick Letter Notes 
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OrthoBanc Setup Wizard 
We added a new field, Account Description on the Existing Provider Account Setup screen, where you can 
enter a description or location for the provider account. This information is added to the new Description 
column on that screen. 

Patient Information 
• The order of the toolbar navigation buttons is now consistent across the following patient-centric dialog 

boxes:  

• View a Patient 
• Edit a Patient 
• Ledger 
• Treatment Card 
• Documents 
• Patient Comments 

• You can now filter by chat messages on the Edit a Patient, History tab. For each chat message listed, there 
is a View button, which you can click to view the message thread associated with the chat message. You 
can only view messages between you and the patient, unless you have the appropriate application right 
(described in the next bullet). 

• We added a new application right, View All Patient-Related Chat Messages in Patient History. This right is 
not granted to anybody by default. If you do not have this right (in the Patient category), the message 
“**You do not have rights to view this chat message**” would appear instead of the View button. 

• The patient History tab, View pull-down menu has a new option: Online Activity, on which you can filter. 
The following patient-activities will be logged as online activities: 

• For practices using Online New Patient Forms, when patients add themselves via online forms or 
schedule their first appointment. 

• For practices using MyOrthodontist, when patients or billing parties update demographics, 
appointment preferences, schedule appointments, or submit a signed document. 

• We added a Questionnaire button to the Edit a Patient tool bar. If you have Super Questionnaire enabled, 
click this button to open a questionnaire for that patient; if you do not have Super Questionnaire enabled, 
the standard questionnaire opens for that patient. 

• There is now a tooltip over the birthday cake icon that displays the patient’s age or the age he or she will be 
on their next birthday. 

• We added new information to the Description column for SMS messages on the Edit a Patient, History tab. 
We now include the date and time for sent, received, and “to send” SMS messages. Additionally, we 
include the message type (either General or Appointment Reminder). 

• We changed the Doctor label at the bottom of the Add a Patient dialog box to Non-Referring Doctor, for 
clarification purposes. 
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Patient Comments 
• We added a right-click menu to the Text column contents in Patient Comments: 

• Cut (available for comments entered today only) to cut the current selection and add it to the Windows 
clipboard. 

• Copy to copy the current selection to the Windows clipboard. (This works for historical comments as 
well as current.) 

• Paste (available for comments entered today only) to paste the contents of the Windows clipboard to 
the current comment. 

• Select All to select all text in the comment you are editing. 
• Create New From This Comment to copy the selected text into a new comment with today’s date. (If 

you have highlighted some of the text, only the highlighted text is added to the new comment). 

• We added a new Correspondence toolbar button to the Patient Comments dialog box with three options: 
Add Letter, Send SMS Message, and Send Email Message. If the patient has no SMS phone number or 
Email address on file, the Add Letter toolbar button appears instead of the Correspondence button. 

Patient Sign-in 
The Patient List sign-in method now lists patient appointments in status Scheduled or the first GPS status your 
practice uses. 

Reports 
• For our Australian customers, we updated the Australian Charge Receipt report to include the tooth 

number in the description section. 
• We added a new report, Patient Team Assignments for Active Patients, which lists all active patients, their 

assigned location, team, and status. 
• We added a new report, Credit Cards Expiring with Recurring Payments, which shows which credit cards on 

file are set to expire before the next recurring payment date (within the selected report date range). 
• We added a new report, Contracts with no Recurring Payments, to the Financial category. 

 
• When you email a report from DIRT, the Email Message Setup dialog box now includes a field for Default 

Billing Party. 
 

• We added the following fields to the Patient report category, Financial Fields field category in DIRT: 
 

Billing Party’s Next Payment Plan Payment Amount 
Billing Party’s Next Payment Plan Payment Date 
Billing Party’s Next Recurring Payment Amount 
Billing Party’s Next Recurring Payment Date 
Default Billing Party’s Next Payment Plan Payment Amount 
Default Billing Party’s Next Payment Plan Payment Date 
Default Billing Party’s Next Recurring Payment Amount 
Default Billing Party’s Next Recurring Payment Date 
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• We added the following fields to the Treatment (beta) Field Category: 
 
Field: Treatment Discount Description 
Field: Treatment Discount Code 
Field: Treatment Discount Amount 

• To support the Teams feature described under Schedule, we added the Patient’s Default Team Name field 
to the Patient report category, Patient field category in DIRT. 
 

• We added the following fields to the Patient report category, Billing Party, Default Billing Party, Default 
Doctor, and Patient field categories in DIRT: 

Billing Party’s Primary SMS Phone Number 
Default Billing Party’s Primary SMS Phone Number 
Default Doctor’s Primary SMS Phone Number 
Patient’s Primary SMS Phone Number 
 
When more than one SMS phone number is stored, these fields pull the first SMS number listed. 
 

• We added an Employee report category to DIRT, and it contains one field category, which is Employees. 
The Employees field category contains the following fields: 

Employee Is Assistant 
Employee's BirthDate 
Employee's City 
Employee's City State Postal Code 
Employee's Email 
Employee's First Name 
Employee's Full Mailing Address 
Employee's Gender 
Employee's Greeting 
Employee's Group Membership 
Employee's Hire Date 
Employee's ID (Guid) 
Employee's Initials 
Employee's Last Login 
Employee's Last Name 
Employee's Last Password Change 
Employee's Login Name 
Employee's License Number 
Employee's Name (First Last) 
Employee's Name (Last First) 
Employee's Postal Code 
Employee's Primary Phone Number 
Employee's Primary SMS Phone Number 
Employee's Salutation 
Employee's SMS Name 
Employee's State 
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Employee's Street Address 
Employee's Termination Date 
Employee's Type 
This Is A Deleted Employee 

• With the addition of the fields listed above, you can now send mass letters, emails, and SMS messages from 
a DIRT report to your employees. 

• We made the following changes to the Hummingbird reports: 

• The Morning Huddle Report: 

• The Practice Goals section uses columnar format. 
• # of Starts column now pulls data from the treatment card. 
• The column order has changed to: Next Appt. Available, Today’s, Yesterday’s, and Goals 
• List (detail) includes all patients who are past due  

•  The Treatment Coordinator Report Summary includes a section called Exams this period, which is now 
based on visits logged in the treatment card. 

• We added a new Hummingbird category, Allergy Alert Types, to contain all custom alert types that 
cover patient allergies. 

The Hummingbird Category, Treatment Starts, should include the following:  

• Full Case Treatments 
• Limited Treatments 
• Phase I Treatments 
• Sure Smile / Insignia Treatments 
• Invisalign Treatments. 

• Added two new reports, Patients in Status – New Patient Added With No Next Proc Date, and Patients 
in Status – New Patient Added with Next Proc Date, which replace the Patients in Status – New Patient 
Added report. 

• We added a Status Reports tab to the Hummingbird Setup dialog box, so you can now generate 
Hummingbird reports based on the patient status or statuses you select. 

• We added the column Patient Current Status, and the Patients in Retention indicating Deband Date 
report now uses the Hummingbird category: Phase II and Full Retention Status. 

• The Patients Scheduled Sorted by Appointment Type Code report is now a DIRT report. 
• We made improvements to the Specific Appointment Type Codes Scheduled in the Future for Range of 

Days report, and you can now send the results to DIRT. 

Schedule 
• You can now track how an appointment was scheduled. On the Appointment Status History screen, there 

is a new field, Appointment Source, which contains one of the following: 
• Dolphin Management (for appointments scheduled within Dolphin Management). 
• 3rd Party Integration (for appointments scheduled via a 3rd-party integration. 
• MyOrthodontist (for appointments self-scheduled by a MyOrthodontist user) 
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• Online New Patient Form (for appointments self-scheduled by new patients via Dolphin Online New 
Patient Form service) 

Additionally, new icons appear on the scheduled appointment that indicate how the appointment was 
scheduled.  

 for Online New Patient Forms  for MyOrthodontist. 

• For practices licensed for MyOrthodontist, you can now prevent patients from scheduling appointments of 
certain types. From the Edit an Appointment Type dialog box, there is a new check box, Disallow patient 
self-scheduling, which, by default, is not checked. If you check this box for a specific appointment type, and 
you have enabled Next Visit Scheduling for your MyOrthodontist users, patients cannot schedule a Next 
Visit appointment of this type. 

• We enhanced the Sooner if 
Possible Appointment 
Reschedule dialog box. Now 
when you click on an 
appointment, an appointment 
summary appears in a panel 
on the right-side of the list 
box:  

 

 

 
• We added a Wks column to the Checkout wizard, Appointments step. This column shows the value entered 

in the Weeks Out column on the patient’s treatment card, Next Visit entry. 
 

• You can now add an Alerts column to the Patient GPS pane layout. 

Patient GPS->Setup->GPS Panes Setup->Edit/Add->Columns tab 

Any alert types that have been configured as visible in the Scheduling Grid (Alert Type->Modules tab) will 
be displayed in the Alerts column. Additionally, you can mouse over the alert to see a tool tip. 

• We added a new option to the Light Bar Status dialog box: When doctor checks into this status for an 
appointment, automatically switch other appointments in this status for the same doctor to the 
following status: In addition to this option is the Auto Status drop-down field where you can choose any 
other lighting status. For example, if you enable this option for the Doctor Treating status, and the drop-
down field is set to Assistant Treating, and the doctor moves from Chair 1 to Chair 2 (where the assistant is 
treating), the following will occur: 

• When the doctor switches the light bar status for Chair 2 to Doctor Treating, the system changes the 
status on Chair 1 to Assistant Treating. 

• The Assistant assigned to the chair will be switched to the last known assistant working on the 
appointment (based upon previous lighting status changes), and the Doctor assigned to the chair will 
not change. 
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• We added a new application and employee right, Light Bar – Change Priority, which is assigned to no 
employee, by default. 

When given this right, an employee can change the priority for a chair on the light bar in one of the 
following ways: 

• Right-click and select Change Priority 
• Double-click on the chair on the light bar 

If more than one appointment has an assigned priority number, a pop-up bar appears, which you can use 
to change the priority of the selected chair. This causes the other appointments to be re-ordered based on 
their prior priority order. 

• You can now track and view patients for whom you left a message to confirm their appointments. You can 
access this: 

• In Scheduling, right-click on a scheduled appointment, and select Left Message. 

A new telephone icon appears on the appointment: 

 
When you hover over the appointment, the date and time you logged the call is also shown. 

• In Appointment Reminders, right-click on an item in the list, and select Left Message. 
• On the Unconfirmed tab in Scheduling, the date and time you logged the call is shown.  

Additionally, you can track this in DIRT, using these new fields in the Schedule category: Appointment Left 
Message, and Appointment Left Message Date and Time. 

• When you reschedule a confirmed appointment (right-click, drag and drop, etc.), Dolphin Management 
now prompts “Is this appointment still confirmed?” If you click Yes, the appointment retains its confirmed 
status in its new slot. If you click No, you need to confirm the appointment again after rescheduling it. 

• When you reschedule an appointment for a different time on the same day, the prompt now reads “Since 
you’ve placed this appointment on the same day, do you want to mark this appointment as patient 
rescheduled?” 

• The Options drop-down menu includes the following new, per-computer options (off by default): 

• Hide Patient Image in Appointment Tooltips: When activated, the patient image no longer shows in 
mouse-over scheduled appointment tooltips.  

• Show patient total/past due icons on appointments: When activated, a currency symbol appears on 
scheduled appointments (red when patient’s past due amount is greater than zero, green when 
patient’s total due is greater than zero, and blue when patient’s total due is less than zero).  
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• Show patient total/past due balances in appointment tooltips: When activated, any non-zero past due 
or total due balance amount shows in mouse-over tooltip. Users must have the View Financial Balance 
Summaries application right to use this option.  

The Schedule Printing Options dialog box has a new option, Number of Days to Print. 

• We changed the GPS Status Bar Options menu as follows: 
 

 
• Right-click any appointment status on the GPS Status Bar to open the options available to you. 

 
• You now access the “Flash” options via a new menu option—Configure GPS Notification Options, 

which opens the new Patient GPS Notification Options dialog box.  This contains two tabs: 
Notifications and Voice Settings.  

The Notifications tab contains the “Flash” settings previously on the GPS Status Bar Options menu, but 
now these settings are per computer. Additionally, there are options to Play a sound on this computer 
when appointment enters status and Play a sound on this computer when appointment leaves 
status. These options are available for appointment statuses: Scheduled, Reception, Seated, Ready for 
Checkout, and Dismissed. When you enable the Play a sound options, you can choose between a 
spoken voice and a custom sound file in .WAV format. 

 
The settings for Spoken Voice and Sound File are global for the practice, however, whether to play 
sound notifications is per computer. 

 
• The Voice Settings tab is where you specify the gender, volume, and speed of spoken notifications. 

• The text used to show appointment status in Patient Navigator, GPS bar (at the bottom of the schedule) 
and appointment history, is now colored according to the assigned status color. 
(EditScheduleAppointment Statuses) 
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• The Appointment Status History screen now has four new fields: 

• Confirmed-- whether the appointment was confirmed or not 
• Date/Time Confirmed— (if applicable) 
• Confirmed Via—how the appointment was confirmed: Email, 3-rd Part Integration, Schedule, SMS, 

MyOrthodontist, HouseCalls, or N/A 
• Left Message—date/time your practice left a message regarding the appointment (if applicable) 

Additionally, we added Assistant and Orthodontist/Provider columns to the Light Bar Status 
Changes section. 

• We added a new check box on the Appointment RemindersSMS Message tab Scheduled Message 
tab: Send message when appointment scheduled. This instructs Dolphin Management to send this 
message whenever an appointment is scheduled. If you want to send a different message or not send any 
message for a specific appointment type, you now specify that on the Edit an Appointment Type dialog 
box, described under Edit Menu earlier in this document. 

• The Enable Scheduled Reminder Message check box on the Appointment RemindersEmail Message tab 
works the same way. When checked appointment reminder emails are sent whenever an appointment is 
scheduled. If you do not want this message to go out for certain appointment types, you now specify that 
on the Edit an Appointment Type dialog box, described under Edit Menu earlier in this document. 

• If an appointment reminder scheduled via Email or SMS is referring to an appointment that was cancelled 
or rescheduled, that reminder message moves to an Auto Delete status. 

• You can assign patient teams to chairs on your schedule templates. On the Schedule Template dialog box, 
click in a column, and select Assign Patient Team to Column(s). Then apply this template to your schedule. 
The Column heading changes to match the color associated with the team, and the name of the team 
appears below the column or chair name: 

 
 

• The Search Schedule now includes a Team field for those practices that are using the patient teams 
feature.  The new, System Options, Scheduling tab field Default Appointment Search Team to Patient 
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Team corresponds this feature. When selected, the appointment search defaults to the patient’s assigned 
team, if he or she has one.  

• For chairs assigned to patient teams, the Light Bar, and Patient GPS (pane layout) will show the team color. 
Patient must be in a seated status. 

• A green highlight appears on patient appointments in GPS when the following conditions are met: 1) the 
current time is earlier than the appointment start time; 2) the patient signed in early, and the number of 
minutes early is more than or equal to what is defined under 
EditPracticeLocationsOptionsMinutes before early message. 

• The Schedule Templates list now shows the color assigned to each template. 
• We changed the way you rename columns on schedule templates. In previous releases, you clicked the 

column header and typed in the name. Now you right-click the column header and select Set Column 
Name(s). Enter the new name in the Set Column Name dialog box: 
 

 
You also have the option to right-click on a column and select Reset Column Name(s) to revert that column 
to its default name. 

• When you reschedule an appointment, Dolphin now prompts you with the same pop-window that appears 
when you make a new appointment. If you have set up automated appointment reminders via SMS and/or 
Email, those settings are honored for the rescheduled appointment. 

Scheduled Jobs 
We added new settings options to the Send Email Messages scheduled job and the Send/Receive SMS 
Messages scheduled job.   

• When you click the Settings button on the Send Email Messages job, the Email Send/Receive Settings dialog 
box opens. Here you specify the user under which the job should run and the maximum number of days 
past after which an email is too old and should not be sent. The default is 21 days. 

• When you click the Settings button on the Send/Receive SMS Messages job, the SMS Send/Receive Settings 
dialog box opens. Here you specify the user under which the job should run and the maximum number of 
days past after which an SMS message is too old and should not be sent. The default is 7 days. 
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SMS/Email Manager 
We added a new message status, Auto Deleted, which you can filter on. This status is used for messages 
associated with appointments that are older than today or have been cancelled or rescheduled. 

SMS Messaging Center 
• Patients and or billing parties can now confirm to the practice when they receive an appointment reminder, 

and you can specify what confirmation codes they can us via the new Confirmation Code field. 
 

 
Any of the comma-separated characters will work when the patient/billing party responds to the 
appointment reminder SMS message. 
 
MainAppointment RemindersSMS Message tabReminder Message sub-tab 
 

• You can create SMS groups of employees based on DIRT reports that use the new data fields from the 
Employee report category (described under Reports, above). 
 

• When editing or creating an SMS Template, you now have the option to specify when the template should 
be available: 

• General means this template is available whenever you want to send a general SMS message. This 
option includes frequency settings. 

• Reminder means this template is available whenever you want to send appointment reminder SMS 
messages. 

• Scheduled means this template is available whenever you want to send messages that an appointment 
has been scheduled. 

Super Questionnaire 
There is a new option on the Super Questionnaire Setup, Options ->Preview Online menu: Fixed Form Layout, 
which is how it is set up in Dolphin Management.  If you also have a license for New Patient Online Forms, you 
will also see the New Patient Online Form option. 

Time Clock Viewer 
We have enhanced the Time Clock Viewer: 

• The Add tool bar button has been renamed to Add Entry. 
 

• We added an Add Time tool bar button, which is available to users who have the application right to edit 
time clock entries. 
 

• This button opens the new Add Bulk Time Clock Hours dialog box. 
 

• You can highlight multiple days in a row on the Calendar View, and these will be reflected on the Add Bulk 
Time Clock Hours dialog box. 
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Treatment Card 
• We added the ability to add custom dentitions to the interactive tooth 
chart. We also include some dentitions by default, which you can edit. To 
access the Custom Dentitions dialog box, click: EditTreatmentTooth 
Chart Dentitions. 

You are required to enter a name to each new dentition. If you enter a 
description, it is used as a tooltip! Each tooth in a custom 

dentition can be marked as Primary, 
Adult, Missing, or Unerupted. If you 
edit one of the Dolphin-provided 
dentitions, and you want to undo your 
changes, select the dentition, and click 
the Restore Defaults button. 

We added a Dentition button to the 
Tooth Chart, which replaces the 
Primary toggle. Click the Dentition 
button to access any custom dentitions 
you create as well as the dentitions 
provided with this release:  

• Mixed (Age 6) 
• Mixed (Age 7) 
• Mixed (Age 8—9) 
• Mixed (Age 10) 
• Permanent (Age 11) 
• Permanent (Age 12—20) 

 

 

From the Tooth Chart, select a single 
tooth, then click the Dentition button, 
and select Set Selected to Primary or Set 
selected to Adult. The other options are 
applied to all teeth, the way you defined 
the dentition in the Tooth Chart 
Dentition screen. 
 
 
 
 

• You can now apply Extract or Uncover to teeth in Tooth Chart Prescriptions. 
• We added the option, Chat Messages to the OptionsShow Entry/Field Types cascade menu in 

Treatment Card. When activated, any chat messages in which the patient was tagged will be displayed in 
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the treatment card grid. A warning message is displayed if you do not have the application right to view 
chat messages. 

• The Appts button, which previously opened the Patient Appointments dialog box where you could view 
the patient’s appointment history, now includes a drop-down menu with the following options: 
• Appointment History – same functionality as before 
• Search Schedule—open the Search Schedule dialog box with this patient’s information 
• Schedule—open the Scheduling dialog box with this patient’s information completed in the patient area 

in the lower left corner. 
 

• We added two new items to the Screen Setup tab: 

• Balance Summary—the patient’s balance summary, which previously required you to set up a custom 
treatment card header. If you check this option and you had previously configured a balance summary 
for your custom header, the custom balance summary will no longer show. 

• Custom Fields—any treatment card custom fields, which previously required you to set up a custom 
treatment card header. If you check this option and you had previously configured custom fields for 
your custom header those fields will no longer show in the treatment card header 

• You can now customize the placement of treatment card items on the Screen Setup tab.  You can choose 
from 6 placement regions (top left, top middle, top right, bottom left, bottom middle, and bottom right) for 
all items on the Screen Setup tab except Appointment Meter and Quick Light Bar. Those items can be 
shown or no-shown only. 
 

• You can now use the following 
characters when entering start and end 
date in the Weeks Out (W/O) field for 
Next Visit entries. 

• Slash (/) 5W/9W (5 weeks out start 
date and 9 weeks out end date) 

• Backslash (\) 2W\3W (2 weeks out 
start date and 3 weeks out end date) 

• Comma (,) 5W,7W (5 weeks out start 
date and 7 weeks out end date) 

You can use normal shortcut date 
notation, such as 1W3D, 3M, 1Y-1D, for 
example 

As entered, these date ranges will appear in the following places as projected: 

• Next Visits tab in patient navigator 
• Checkout wizard 
• Treatment Card (providing the Show calculated or scheduled next visit date option is active for the 

W/O field) 
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These date ranges will prefill the Start Date and End Date fields for schedule searches performed for 
Next Visits in the Checkout wizard. Any end date range specified via this enhancement will override the 
weeks after setting of MyOrthodontist Next Visit Scheduling. 

• Dolphin now integrates with EasyRx via the Treatment Card Setup--> Integrations tab. EasyRx customers 
should contact EasyRx directly for instructions and a required, customer-specific file. 
 

• We now check before allowing you to access Treatment Card Setup, preventing it if another user is 
currently editing the treatment card setup, or if another user has a patient treatment card open. 
 

• We added a new field type, Last Appointment Weeks, to Treatment Card Setup. This field automatically 
populates when new Visit and Emergency entries are logged, and it shows the number of weeks since the 
patient’s last dismissed appointment.  If the field shows N/A, there is no prior dismissed visit, or the visit 
was entered prior to this release. 
 

• Letters generated from the treatment card (Treatment Card Field Auto-Letter) can now include the 
patient’s tooth chart. 
 

• You can now create custom lookup items for treatment card comment entries. You define these on the 
new Quick Comments tab on the Treatment Card Layout dialog box. If staff members find themselves 
typing the same information in a treatment card comment, they can use these new lookup items instead. 
You set up custom lookup items for each treatment card layout you use. When adding a treatment card 
comment entry, click the ellipses to open the list of custom lookup items: 
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• We added the Show Entry/Field Types... submenu to the Treatment Card, Options menu, and moved the 
following “Show” Options previously part of the Options menu to the new sub-menu. Additionally, we 
added two new “Show” options: Hidden Fields and Hidden Entries. 
 

 

Any fields marked Field is hidden by default in the Treatment Card Setup, Treatment Card Field-->Field 
tab are hidden when you open the patient Treatment Card. To temporarily see these fields on the 
Treatment Card, select OptionsShow Entry/Field Types…Hidden Fields.  You can specify how long 
hidden fields display when you activate the “Show” option. On the Treatment Card Setup, Options tab, 
enter the number of minutes in the new Hidden Fields Auto-Hide Minutes field. 

• For practices licensed for MyOrthodontist and/or Online New Patient Forms, we added the option, Online 
Activity to the Show Entry/Field Types cascade menu in Treatment Card.  

• We added a Show Entry/Field Types button at the lower left corner of the treatment card grid. Click this 
button to open the floating toolbar shown below. The buttons on this toolbar correspond to the options on 
the OptionsShow Entry/Field Types sub-menu described above. Click anywhere off the toolbar to close it. 
These options are specific to the logged-on user. 

 
• When you drag and drop a planned visit item to the treatment card to create a NV entry, Dolphin 

Management completes the WO column with 0W if the calculated weeks out is less than or equal to zero. 
This indicates that you should schedule the visit today or ASAP. In previous releases the WO field remained 
blank in this scenario. Additionally, if the treatment card was set up with the Validate Next Visit entries 
option checked, previously Dolphin Management required an entry in this field to save the entry. 

• On the Treatment Notes dialog box, you can now delete either the highlighted item or one or more 
checked items at once. Previously you could delete one item at a time only. The notes on this dialog box 
are used for treatment card and treatment plan notes. You access it by clicking on the Lookup button on 
the treatment card or plan Notes tab. 
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• We changed the message that appears when you attempt to save a treatment card, and a Visit, Emergency 
or NV entry is missing a required field: 

• If the field is required but is currently hidden, the message reads: 

“field is a required field but is currently hidden from view. You will need to first show hidden fields, 
then enter a value for this and any other required field(s).” 

• For all other non-hidden required fields, the message reads: 

“field is a required field. Please enter a value for this and any other required field(s).” 

• We improved the scaling of images associated with treatment card integration entries, such as EasyRx. 

Zuelke Financial Expert 
At a customer request, we added an extra column, D, for the orthodontist’s initials. This column appears next 
to the TC column on the Cast Start Tracking Form for A, B and C Patients. 
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